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This section of the manual describes the tools available in CAN-8 to administer and 

manage the system. 

Some of these tools are available to Instructors, some however are not and can only be 

used by the System Administrator when signed in with the System Administrator's 

ID: MASTER .  

 

This ID comes with the system and cannot be deleted.  

 

Whereas it is usually assigned to one user, this user ID can, if necessary, be shared by 

more than one user.  

 

  NOTE 

Note that it is not possible to create 2 system user IDs. If the responsibility of the 

system's management must be shared, then the ID must be shared, which means 

only one person can sign in CAN-8 as system supervisor at the same time. 

 

I - System Tools 

The table below lists the tools available to administer your system and your users and the 

privilege needed to use them:  

Tool: 

Available to: 

Description: System 

Admin ID 

Instructor 

ID 

Menu 

Creation 
Yes No 

Used to create new items in the Main Menu 

(submenus, lessons, media links, ...), change 

existing menus and re-arrange menu content. 

System 

Attributes 
Yes No Controls menu access by users or classes 

System 

Refresh 
Yes No 

Refresh the system of all users and their data at 

term end or when desired using an import file. 

The menu layout and the lessons are not impacted 

by this action.  

 Import 

Registration 
Yes Yes** 

Allows the System Supervisor to create, change 

or delete a list of users (students and instructors) 

and classes using a tab separated text file.  

** Since the 2015 09 29 version of CAN-8, 

instructors can use an import file to create 
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Tool: 

Available to: 

Description: System 

Admin ID 

Instructor 

ID 

their students and classes. They cannot create, 

delete or edit instructors' profiles not can they 

use it to delete other users than their own 

students, or delete classes.  

In versions of CAN-8 pre-dating 2015, 

instructors cannot use import files. 

Class 

Function  
Yes Yes 

Organizes student in groups for easier 

management. 

Manual 

Users 

Registration  

Yes** Yes 

Used to create, edit or delete users. 

** Note that the System Supervisor can ONLY 

register instructors using that tool, while 

instructors can only register/edit/delete 

students.  

Although the system supervisor cannot register 

students with this tool, she/he can edit or delete 

their profile.  

Activity 

Reports 
Yes Yes 

Display a log of the activities recorded in CAN-8 

per user, date, or class group. 

 

II - System Attributes 

About Attributes 

The System Attributes are used to show/hide menu entries to the users by matching an 

attribute assigned to a menu or lesson to a profile or a class. A user with the attribute X 

will see the menu with the attribute X only.  

 

It is therefore important to take the time to figure out the overall menu layout before 

proceeding with its creation so that attributes can be added as you create items and users. 

It will be much more time consuming to set up the attribute system after the menu entries 

are created.  

 

Although other tools are available in CAN-8 to show/hide specific menus to the users, the 

attributes allow a much more flexible menu display.  
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  NOTES 

• Because menu items, classes, and users are created with all of the attribute 

positions preset, when a new attribute entry in the Attribute column is created in a 

formerly blank space, this entry will be automatically added to all existing menu 

items, classes and users. It is therefore best to have a well-developed plan of 

attributes before creating menu items, classes and users.  

• Although it is possible to design an attribute system at a later date, when the 

menus have already been populated, it will require much more time since each 

menu will then have to be edited to reflect the new design.  

 

System Attributes Assignment Sample  

The first step when defining system attributes is to create a layout of the system's 

organization.  

 

This layout is unique to the need of each site, and therefore can only be created by the 

site administrator in consultation with the instructors. The following sample is only 

meant to illustrate how attributes are used:  

 

In this illustration, Site A offers several language courses, each language divided by 

fluency level. Users progress over the sessions from Level 1 to 4:  

The attributes selected represent each language, and each level.  

 

When each menu is created, it is assigned an attribute, as defined in the attribute table. 
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For example, in this illustration, the English menu is assigned attribute E and the French 

menu is assigned F. The Introductory level submenus for both languages are assigned the 

attribute 1, while attribute 2 is assigned to LEVEL 2, and 3 to LEVEL 3.  

When students are registered, they are assigned the attributes for the menus that they will 

use. For example, a student with the attributes E, 1 will see only see in the menu the 

LEVEL 1 of the English menu, while a student with the attributes E, 1, 2 will see LEVEL 

1 and LEVEL 2 English submenus. Next session, the next level's attribute can be added 

to their profile and they will be able to see the next level's entries in the menu.  

 

Similarly, attributes can be assigned via classes. When a class is created, you can assign 

the attributes for the menus that will be used by that class. All students added to that class 

will inherit these attributes independently of the attributes assigned in their profiles. This 

facilitates the users' assignment. Simply changing the attributes for a class will change 

the attributes for all students (and instructors) who are members of that class.  

If you create a class per level with the corresponding level's attribute, then simply adding 

the student to the next class will add the new attribute to the student's profile.  

 

  NOTES 

• Classes can add or remove attribute from a user profile. Removing attributes from 

a profile via classes is detailed in the class creation chapter. We strongly 

recommend reading that section before proceeding.  

• Attributes are inherited from the user who creates the profile. For example, if an 

instructor only has the E attribute in his/her profile, the students registered by this 

user are created with the attribute E only. This will greatly simplify and speed up 

the manual creation of users. 

• Users' and classes' attributes can be changed (added or removed) via an  

• import file  

• Attributes can be cumulated with Menu tags to restrict the menu display.  

 

Defining System Attributes 

Although instructors can assign attributes to students and classes, only the System 

Supervisor can define them in the system and assign them to menus.  

 

Up to 16 system attributes can be defined. Each one consists of a single letter or digit, 

and of a brief description of the attribute use. The selection of the letter and the 

description is left to the System Supervisor in consultation with the instructors.  

 

The letters or numbers in the Attribute column are selected as mnemonic aliases for the 

attribute numbers. A simple system that uses E for English, F for French, and S for 
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Spanish for example is recommended. However, the selection of letters is arbitrary. Any 

letters or digit can be used to classify the menu items.  

   

  NOTE 

By default, the CAN-8 system comes with one pre-defined attribute (attribute D). 

It is automatically assigned to all menu items and users created. 

This attribute can be changed/removed at the user's discretion.  

 

To define the system attributes: 

 

• Sign in with the MASTER ID  
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• In the main Menu, choose System Administration then Edit System Wide 

Attributes.  

On a new system, only the D - Default attribute - shows in the list.  

• In the Code field, type a single letter or digit (1-9) for the first attribute you want 

to define.  

• In the Description field, type a description.  

• Even if you only need to define a few attributes, we recommend that you define 

all 16 as space saver (see illustration). This will simplify your task if you need to 

add them later. For example, enter X as the letter, and For Future Use as the 

name. You can later change that letter and that name when needed. If you do not 

do that, any attribute you add to this window later will be added to all your menus 

and you will have to remove them all.  

The Attributes assigned to menus only show on the System Supervisor's interface. 

Students and instructors will not see them when they sign in. The attributes descriptions 

can only be viewed in this window.  

Using System Attributes to hide menus 

Once the system attributes have been defined, any menu/sub-menu/lesson and user 

created will get all the attributes. The unwanted attributes can be removed at the time of 

creation. (This will be detailed later on in this chapter).  

 

Note that: 

• If all system attributes are removed from a menu entry, no CAN-8 user will be 

able to see this menu EXCEPT the System Supervisor.  

This can be used as a tool to hide tests or courseware the users are not meant to 

access. To show it again, add one of the attributes to the activity.  

• Removing all attributes from a user's profile will hide all menus from that user 

and is not recommended unless that user is placed in a class that adds the 

attributes needed to access a sub-section of the menu. The system supervisor is 

the only exception. It is not possible to remove attributes from the system 

supervisor's profile.  

• If a user is registered with all the system's attributes, the extra attributes can be 

removed manually or via the class they belong to.  
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III - Managing Menus 

About the CAN-8 Menus and Menu Items 

Depending on the type of profile the user is registered with, the menu displayed is 

different: 

User 

Profile 

Type   

Students' Menu 

And Sub-Menus 

Instructors' Menu 

And Sub-Menus 

System Supervisor's 

Menu 

And Sub-Menus 

Students Yes No No 

Instructors  Yes Yes No 

System 

Supervisor  
Yes Yes Yes 

 

 

 

 

The illustration above is the default menu assignment per user role. These pre-defined 

menus already include certain entries. On a new system, they are the functions such as 

Register Users or Change your Password. These entries types are called Internal 

Command: they link to a system function.  

 

This default menu assignment can be changed to restrict the access to a specific submenu, 

as seen in the attributes section. It can also be changed to give access to a higher level 

menu. For example, Instructors can be given access to the Master menu, but their access 

to the functions will not change. This instructor will see for example the link to Edit the 

attributes, but the system will restrict the instructor from accessing this function as it is 

reserved to the system supervisor.  

 

 



 

11 

 

  TIP 

• Since students cannot access the Instructors menu, activities that are in the 

process of being developed should be placed in the instructors' menu until they 

are ready to be published, at which point they can be moved to the students' menu.  

• Tests that are ready but should not be accessed by students can also be placed in 

the instructor's menu until exam time, then they can be added to the students' 

menu the day of. Other tools such as the wait to start option can be used to place a 

test out of reach.  

 

Adding Items to The Menu 

As the CAN-8 data base is growing, new menu entries have to be created. The System 

Supervisor (signed in with the Master ID) is the only user who can create and edit menus. 

Although Instructors can create the content of a lesson, they cannot create, edit or delete 

the menu entry for that lesson in the main menu.  

 

To add an entry in the menu:  

• Sign in with the MASTER ID  

• Right click on the menu area where the new entry should be placed, then in the 

popup menu, select one of the 3 options available.  

 

• This will bring a form that you will need to fill with specific information.  
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o Menu Item Name field.  

This is the title of the item that will show in the menu. This field can 

include a maximum of 69 alphanumeric characters as well as symbols. 

Every menu item must have a name consisting of at least one character.  

o Next, you must select the type of item you want to create. It is important 

to select the type right away as depending on the type you select, different 

fields in the form will activate and will have to be filled.  

 

The instruction section at the bottom of the form will help you identify 

which fields can be left Blank. If left blank, the system will autofill these 

fields, using unique names.  

There are several types of items that can be added to a menu; Each type has a unique 

function and can be recognized by the icon located in the menu before the title. They are:  
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Icon   Type Description Corresponding field(s) activated 

 

EAASy II  

This is a lesson/test 

type entry. The 

instructors will be 

able to add exercises 

and content  

 

It is selected by 

default.  

PATH: This field indicates the path on the file 

server that the selected item is to reside in.  

 

This field can be left blank at item creation time, 

the system will automatically create a path based 

on some of the letters in the menu item name:  

SVI\ABCxxx  

 

If you choose to enter the path manually, be sure 

that the path points to a valid directory name on the 

server and that that you have rights to access it. 

The default path for CAN-8 lesson folder is 

SVI\FOLDER_NAME  

and should be preferably kept so when entered 

manually to keep an organized structure.  

FOLDER_NAME should be composed of a 

maximum of 8 characters or you will receive an 

error message.  

 

 

Submenu - 

closed  

Each submenu created 

in the system can 

include up to 254 

items, including 

nested submenus up 

to a maximum depth 

of 10 linked 

submenus.  

MENU TAG: This field can be left blank during 

item creation. The system will assign a non-

conflicting tag for the submenu you are creating.  

 

Tags are composed of 6 alphanumeric characters. 

They can be entered manually at creation but 

cannot be edited after.  

 

If entered manually, choose a descriptive tag will 

be easier to remember for future use:  

ENGL01 for English Level 1 for example.  

 

This menu Tag can be selected in the user's profile 

as the INITIAL MENU.  

 

 

Submenu - 

expanded  

 

Application 

link 

Provides a link to 

external applications. 

When the path to an 

application is 

provided in the path 

field, and the 

application executable 

placed in the 

Application field, 

clicking on this menu 

The PATH and COMMAND fields MUST be 

manually filled.  

 

PATH: Type in the path to the folder where the 

Application's main executable can be found.  

 

COMMAND: Type in the name and extension of 

the executable that you wish to run.(i.e.: 

notepad.exe)  

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/admin.html%23u0016
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Icon   Type Description Corresponding field(s) activated 

link will start the 

application in a 

different window. 

 

INTERNAL 
Link to one of the 

CAN-8 functions. 

Internal  

 

Select the command name associated to the CAN-8 

function you wish to create a menu item for.  

 

The complete list of all available internal 

commands can be accessed via the dropdown 

selector. Click on the command to select it.  

 

Internet link 

Opens the default 

browser and links to 

listed site  

URL 

Type in the URL of the website you want the user 

to reach.  

 

Media link 

Provides a link to the 

default media player 

on the workstation. 

When selected in 

CAN-8, this entry will 

open via the default 

media player any file 

the media player 

supports. (Audio 

and/or videos) 

external applications.  

MEDIA 

 

Type in the path to the media.  

 

This path must be valid on all workstations. 

 

If this path points to C:\AUDIO, all workstations 

have to have an AUDIO folder on the C drive, and 

if it points to F:\AUDIO where F is a network 

share, all stations must have a mapped drive named 

F pointing to the drive where the shared AUDIO 

folder is located.  
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• Once you have selected the type and filled the corresponding fields (if required), 

select the Attributes tab:  

 

You will find a list of all the system attributes available. By default, they are all selected.  

 

Only keep the attribute(s) that apply, deselect the others. For example, based on this 

illustration, if the menu is meant to be shown only to students in Italian, Level 1, 

Advanced, then all attributes should be deselected except for I, A and 1.  

 

If you do not use attributes to assign menus, leave all the attributes selected and go back 

to the main tab.  

• Click OK to finalize the creation.  

• The new entry is now in your menu in red font. You must save the changes to the 

menu before you can open this item. Select FILE then SAVE in the top menu, or 

right click on the menu and select SAVE in the contextual box.  
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Editing Items in The Menu 

If you'd like to make changes to an existing menu Item:  

• sign in with the MASTER ID  

• Right click on the item and select Properties  

• Make the changes.  

• Select OK  

• At the message This menu/lesson already exists, do you wish to link to it? select 

YES  

• The edited item is shown in red font. Save the changes to the menu under FILE 

then SAVE in the top menu.  

   

  NOTES 

Some of the fields such as Path and Menu Tag will be greyed out. You cannot 

change these. 

 

Moving Items in the Menu 

You may need to move an activity (test or lesson) that has been developed from the 

instructor's menu to the student's menu so they can access it. Or you may just want to 

reorganize your main menu differently.  

To do so: 

• sign in with the MASTER ID  

• Drag an existing entry from a menu and drop it in another location. The name and 

type of item being dragged is greyed out and an arrow shows where the item will 

be dropped when the mouse button is released. 

 
• The item that was moved will be in red font. You must save the menu before the 

changes take effect. Use FILE > SAVE in the top menu or right-click on the menu 

and select save.  

  NOTE: 

If you move an item by mistake or dropped it accidently and cannot find it 

anymore, you can select Abandon Changes under File in the top menu. Any 

changes that were made after the last saved menu will be undone.  
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View Menu Items Properties  

You may occasionally need to view the tag and attributes of a submenu to assign it to a 

user or view the attributes and the path of a lesson.  

• Sign in with the ID MASTER  

• Place your mouse over the menu entry and hold it there.  

• A yellow popup appears after a few seconds  

 

 

o If you mouse over a lesson, you will see its type, its attributes and its path  

o If you mouse over a submenu, you will see its type, its attributes and its 

menu tag.  

 

Making a Copy of a Lesson/Test.  

By making a copy of a lesson, we mean creating an independent but identical lesson/test 

that can be edited without changing the original lesson.  

To create a copy:  

1. Sign in with the MASTER ID  

2. Create a new menu entry of the type EAASy II where you want to place the copy.  

3. Open the Planner of the original lesson. All items included in this lesson are 

visible in the planner's menu.  

4. Open the Planner of the new menu entry. This Planner is totally empty.  

5. Select all the items from the first Planner and paste them in the empty planner.  

6. exit both Planners.  

 

NOTE 

*** Steps 3 to 6 can be done with an instructor's ID. The system supervisor can 

sign out after creating the menu entry and leave the other steps to the instructors. 
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Linking to an Existing Lesson or Submenu 

Linking to a lesson differs from copying a lesson in one fundamental way. Both allow 

you to create a similar activity (lesson or test) in different part of the menus: But whereas 

copying an activity creates a second independent lesson that can be edited without 

changing the original lesson, linking to an existing activity only creates a logical link to 

that lesson. Therefore, any changes done to the linked lesson will also appear in the 

original lesson.  

 

It is also possible to link to an existing submenu and its content using the same menu 

Tag. The Class Functions submenu is an example of that. It is present both in the System 

supervisor's menu, and in the instructors' menu.  

 

 

To create a link to a lesson:  

• Sign in using the ID MASTER  

• In the menu, place your mouse cursor over the lesson/test you wish to link to.  

• Note the path shown at the bottom of the yellow pop up box that appears after a 

few seconds.  

• Then locate the menu area where you wish to place the link and  

• Create a new menu entry of the type EAASyII.  

• Type the title of the lesson as you wish it to appear  

• Enter the exact path you noted earlier.  

• Select OK  

• At the message This lesson already exists, do you wish to link to it? select YES  

• Save the changes to the menu. (FILE - SAVE in the top menu)  

 

To link to an existing menu 

• Sign in using the ID MASTER  

• In the menu, place your mouse cursor over the menu you wish to link to.  

• Note the Menu Tag at the bottom of the yellow pop up box that appears after a 

few seconds.  

• Then locate the menu area where you wish to place the link and  

• Create a new menu entry of the type Submenu.  

• Type the title of the menu as you wish it to appear  

• Enter the exact menu tag you noted earlier.  

• Select OK  

• At the message This Menu already exists, do you wish to link to it? select YES.  

• Save the changes to the menu. (File - SAVE in the top menu bar)  
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 NOTES 

• Any changes in the Planner or in the Tracker of a linked lesson will also 

impact the original lesson.  

• Any changes to a linked menu will impact the original menu.  

• Any changes in the Planner or in the Tracker of a lesson that is included in a 

linked menu will also impact the original lesson.  

 

 

IV - Background image 

There are 2 kinds of background images in CAN-8. The one added to a lesson or an 

activity and is directly related to the subject being taught, and the image that will be 

affixed to the CAN-8 main interface when the user first signs in. It may represent the 

logo of the organization or department using CAN-8, or their mission.  

 

The latter will be placed in the user's profile but must first be imported into CAN-8 by the 

system administrator. Multiple images can be imported.  

 

  NOTE 

Whereas instructors can assign a background image to the students they create, 

they can only choose among images previously imported in CAN-8 by the system 

administrator.  

 

To import an image: 

• Sign in with the system administrator's ID and password  

• From the top menu, select Edit > Background image.  
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• The image selector appears.  

 

 

Identify on your disk the image you want to import, then drag it directly into one 

of the empty boxes. The first box (0) must remain empty. It is reserved for the 

CAN-8 default interface.  
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This selector can hold up to 99 background images. In this illustration, there are 2 

images, one in the box labelled 1, one in the box labelled 2.  The first box is 

reserved for No background 

The maximum size for these images is 320px by 240px.  

To change your background image, 

• Sign in with an instructor’s or the system administrator's ID and password  

• From the top menu, select Edit > Background image.  

• Select the image of your choice (the frame becomes blue)  

 

• Exit the selector.  

V - Users & Groups Administration 

CAN-8 users will be assigned a unique ID and a password in order to login. They can 

also be assigned a specific menu. This section of the manual details the creation of the 

users and the different methods to assign menus to their profiles. Grouping them in 

Classes is not only a way to restrict their menu, it also facilitates the monitoring display 

for the instructors. We start this section with class creation, since you can then add the 

users to the class during registration, but it is equally fine to start by the users' registration 

before the class creation and add them to a class later.  

About Classes 

Classes are virtual grouping of students provided to ease their management.  

 

Using classes, an instructor can:  

• start a test for a group of students as opposed to one student at a time.  

• limit the display of all answers in a Tracker to only the display of the users 

belonging to a defined group  

• control the attributes assigned to a group of user profiles, thus limiting the menu 

access for that group of users.  
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Important points to remember about classes are:  

• Both the System Supervisor and the instructors create classes.  

• Users can belong to up to 16 classes.  

• Classes can ADD or REMOVE attributes from a user's profile.  

• When students belong to several classes, students' attributes are managed by the 

first class listed in their profile.  

• Instructors who belong to one or more class(es) will only see the students who 

belong to the same class(es). They will not be able to see any of the other 

students registered in the system.  

• Instructors who do not belong to any class can view all students registered in the 

system, including those who belong to any of the system's classes.  

• Instructors who belong to several classes can use the VIEW > BY CLASS 

option, but only have the choice of viewing one of the classes they belong to.  

• Placing MASTER in a class will have no effect on the MASTER user.  

• Classes can be created or deleted via an import file  

• When a class that includes users is deleted, these users' profiles are not deleted 

from the system. All attributes restrictions that were applied via the class are 

removed upon its deletion and the users regain their regular attributes and access 

to all menu entries.  

• During a SYSTEM REFRESH, classes are NOT deleted from the system.  

• A simple schedule can be entered in each class. During the scheduled period, the 

users belonging to that class who sign in the system will have the class's attributes 

applied to their profile. After the schedules time, the same users signing in the 

system will no longer have the class attributes but will instead have their own 

attributes applied.  

Class Functions Menu 

 

The Create Class command is located in the Class Functions submenu. This submenu 

comes by default with the system but may have been renamed or moved to another place 

by the System Supervisor.  
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Since the instructors can also create classes, this submenu is usually present in the 

instructors' menu as well.  

 

Creating Classes 

To create a class,  

• In the Class Functions menu, select the Create/Modify Class link. 

• The window that comes up is common to both the Create Class function and the 

Modify Class function.  

 

• Class codes are composed of a maximum of 8 alphanumeric characters. In the 

Class Code field, type the code you have previously chosen to assign to the new 

class and select OK.  

 

    NOTE 

class codes can be deleted, but cannot be edited and must be unique 

 

• Once the OK button selected, the class form will display.  
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The Class Code field will already display the code you had entered in the step above. 

Note that you can no longer edit this field.  

 

There are 3 tabs in this form. General Information, Attributes Add and Attributes 

Remove  

 

Each field in that form requires specific information, but not all fields are mandatory.  

The table below details the format required for each field. 
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General Information Tab 

Field 

name 

Field 

state 

Input Description 

Class 

Code 

Mandatory 

- Non-

Editable 

Maximum 8 

alphanumeric 

and 

punctuation 

characters. 

Space 

character 

will be 

ignored.  

This code must be unique in the system. 

Access to any of the other class function will 

require that code. 

Class 

Name 

Mandatory 

- Editable 

Maximum 40 

alphanumeric 

and 

punctuation 

characters. 

Space 

character 

allowed. 

For information purpose only. The name 

shows when a Class Listing is requested 

Term Optional - 

Editable 

maximum 8 

alphanumeric 

and/or 

punctuation 

characters. 

For information purpose only. 

Instructor Optional - 

Editable 

Max 30 

Alphanumeric 

and/or 

punctuation 

characters. 

For information purpose only. The name of 

the user who created the class appears there 

by default. Can be changed to the name of 

the instructor who will teach the class. It 

however does not place this instructor in the 

class, nor does it give this instructor special 

rights in that class.  

Class 

schedule 

- start 

Optional - 

Editable 

24:00 format. If this field is filled, the schedule will take 

effect. If this field left blank, there will be no 

schedule for that class.  

Class 

schedule 

- End: 

Default 

Value - 

Not 

Editable 

N/A This field is to remind that all schedules end 

at 23:59 that day 
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Attributes Add Tab 

Attributes 

Add 

Pre-

selected - 

Editable  

Click to select 

or deselect 

This tab shows all attributes that the class 

has. By default, the class has inherited the 

same attributes than its creator. Any 

attributes listed in that tab will be added to 

the class member's profile, if the class 

member does not already have it assigned. If 

the creator did not have a specific attribute, 

this instructor will not be able to add it to the 

class. The attribute will show but will be 

greyed out.  

 

This is used to show menus otherwise hidden 

in organizations that use attributes for their 

menu layout. 

Attributes Remove Tab 

Attributes 

Remove 

Deselected 

by default 

- Editable  

Click to select 

or deselect 

This tab shows the list of system attributes. 

The Instructor selects the attribute(s) that 

will be removed from the profile of the class 

member.  

 

  NOTE 

Caution should be taken when assigning attributes via classes. If users belong to 

more than 1 class, the attributes selected in the attribute ADD and attribute 

REMOVE of each class are added; therefore the users belonging to class A 

which adds X , and class B which removes X, will have X removed and will not 

be able to reach the menu with the attribute X. See the Case Example for 

alternatives.  

 

Once all the fields of the form are filled in, or at least the mandatory ones, press the OK 

button in the bottom right corner to create the class.  
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Class Schedule 

 

  NOTES 

• Class schedules only apply to organizations using class attributes to limit the 

menu layout.  

• Class schedules DO NOT prevent students from signing in the software outside of 

the scheduled time set.  

• Class schedules are meant only to ease the navigation and simplify the menu 

layout for students who belong to more than one class. If a student is only a 

member of one class, the schedule will have no effect at all.  

• Schedules are initialized upon sign on only. If a user belonging to a class with a 

schedule signs on before the schedule time, the schedule will not take effect at all, 

not even at the scheduled time. The student will have to sign out then back in.  

... 

The content format of these fourteen fields is HHMM. To set a start time for a day of the 

week, the instructor must enter the hour and minute of the beginning of the class. Hours 

are specified in 24-hour format. Two o'clock in the afternoon is entered as 1400.  

 

Each scheduled class begins at its start time and continues until a different class begins or 

the specified day ends.  

Example 

For the purpose of this example, the menu layout has been organized with attributes as 

follow:  

• The menu linking to the Spanish lessons is assigned the attribute S only  

• The menu linking to the English lessons is assigned the attribute E only.  

The instructor creates 2 students, STUD1 and STUD2.  

Student ID System 

attributes 

assigned  

Menu displayed if not in a class 

STUD1 None This user has been registered with no attributes at all, 

therefore does not see any menu when signing in 

CAN-8. 

STUD2 All system 

attributes 

This user has been registered with all attributes 

therefore sees all the students' menu entries when 

signing in CAN-8.  



 

28 

 

The instructor then creates and defines two classes:  

Class Class 

Code 

Attributes 

Add 

Attributes Remove 

Spanish 

Class 

SPAN S All system attributes except S 

English 

class 

ENGL E All system attributes except E 

• If we place both students in the class SPAN, both students will have only the attribute 

S, no matter when they log in:  

o STUD1 will have the S attribute added by the ATTRIBUTE ADD of the 

SPAN class.  

o STUD2 will have all his attributes but S removed by the ATTRIBUTES 

REMOVE tab of the SPAN class.  

o If Both students belong to both classes, we know that as per the class 

attributes rules that if a student belong to several classes, students' attributes 

are added.  

 

So if STUD1 is placed in both classes both S and E will be added BUT S and 

E will also be removed. The same applies to STUD2. So these students will 

see neither Spanish nor English 

 

In this case, either create one class that gives both attributes and removes all 

other attributes, or create users without attributes and create classes that 

ADD the S and E attributes but that do not remove any attributes (deselect 

them all in the ATT REMOVE tab.). Another alternative is to create a 

schedule.  

• If we add a schedule to both classes:  

depending on when the students sign in, they will receive the attribute of the class 

that is scheduled at that time. 

 

Let's assume that:  

 

o The Spanish class takes place at 8:00 AM and at 2:00 PM.  

Schedule entries for SPAN are 0800 and 1400.  

o The English class starts at 10:00 AM; then again at 4:00PM  

Schedule entries for ENGL are 1000 and 1600.  

The table below details the impact of these schedules on the students:  
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Login 

Time 

Student 

ID 

Student's 

attributes 

Visible 

menu 

Attributes received 

12:00 

Am to 

7:59 

AM 

STUD1 None  None Before the class starts, this user has no 

attributes. STUD1 does not see any lesson in 

the menu. 

STUD2 ALL All 

entries 

in the 

student 

menu 

Because all attributes are listed in this user's 

profile, by default all menu entries are 

displayed.  

8:00 

AM to 

9:59 

AM 

STUD1 S  Spanish 

menu  

The S attribute is added to STUD 1 via the 

ATTRIBUTE ADD tab of the scheduled 

class. The student now sees the Spanish 

menu. 

STUD2 S  Spanish 

menu  

All attributes except the S attribute were 

removed from STUD2 via the ATTRIBUTE 

REMOVE tab of the scheduled class. The 

student now only sees the Spanish menu. 

10:00 

AM to 

1:59 

PM 

***  

STUD1 E  English 

menu  

The E attribute is added to STUD 1 via the 

ATTRIBUTE ADD tab of the scheduled 

class. The student now only sees the English 

menu. The Spanish menu is no longer 

available. 

STUD2 E  English 

menu  

All attributes except the E attribute were 

removed from STUD2 via the ATTRIBUTE 

REMOVE tab of the scheduled class. This 

student only sees the English menu 

2:00 

PM to 

4:00PM 

STUD1 S  Spanish 

Menu 

The S attribute is added to STUD 1 via the 

ATTRIBUTE ADD tab of the scheduled 

class. The student no longer sees the English 

menu. 

STUD2 S Spanish 

menu 

All attributes except the S attribute were 

removed from STUD2 via the ATTRIBUTE 

REMOVE tab of the scheduled class. The 

student now only sees the Spanish menu. The 

English menu is no longer available. 

4:00 

PM to 

11:59 

PM 

***  

STUD1 E  English 

menu  

The E attribute is added to STUD 1 via the 

ATTRIBUTE ADD tab of the scheduled 

class. Only the English menu is visible.  

STUD2 E  English 

menu  

All attributes except the E attribute were 

removed from STUD2 via the ATTRIBUTE 

REMOVE tab of the scheduled class. Only 

the English menu is visible.  
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  NOTES 

• The above simulation is only true if the students sign in at the time of the 

schedule. If the students log in earlier and remain online when the scheduled class 

switches, the students will only see the menu from the attribute of the class that 

was scheduled when they signed in.  

• Since by default all schedules end at 11:59 PM, the last schedule that is entered in 

any of the classes the students belong to, is the one that will remain valid for the 

rest of the day. In the case above, the English class at 4:00PM is the one with the 

last schedule, therefore E is the attributes the students will have until 12:00 AM 

(midnight) where their default with start again.  

• If it is necessary to restore the original student's attributes after school hours, a 

third class should be created with a schedule covering the time the students are no 

longer in class until midnight. This "DEFAULT" class will be the one with the 

last schedule and therefore the one last altering the student's attributes for the rest 

of the day.  

• Make sure to fill in both the ATTRIBUTES ADD, and ATTRIBUTES REMOVE 

tabs for the classes.  

 

Edit/Modify Classes 

Although class codes cannot be modified, some other information such as class name, 

attributes, term, schedule and instructor's name can be edited.  

• In the Class Functions Menu, select the Create / Modify Class link  

 

• The form that is presented is common to both the Create Class function and the 

modify Class function.  

In the Class Code field, type the code of the class you wish to modify and select 

OK.  
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• Alternatively, if you do not remember the code of the class, you can leave the 

class field empty and click on the Select button. In the Next pop up window, enter 

the first letter of the name of the class. The list of classes available starting with 

that letter will show. Locate the class name, then click on it and select OK.  

 

• In the class form, change the information required, then select OK.  

 

List Classes 

To display a list of all the classes that currently exist in the system: In the Class 

Functions Menu, select the List Classes link  
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A dedicated window with the list of all the classes and their details will show. 

 

Each column can be sorted alphabetically or by order by clicking on the respective header 

title. (Class Code, Class Name, # Students in Class, Class created by and attributes + / -)  

 

This list can then be saved in .txt or .csv format:  

• Select File > Save in the interface top menu.  

• In the SAVE AS window, type the file's name and select the file format  

• Click on the Save button.  

 

 

Add Student to Class 

To add a student to a class:  

In the Class Functions Menu, select the Add Student to a Class link  
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In the form that appears: 

 

• Type the student ID or use the Browse buttons to select the Student ID from a list  

• Type the class code or use the Browse buttons to select the class from a list 

• Select OK to save the changes to the system.  

• Repeat this procedure for each student to wish to place in that class.  

 

  NOTES 

• The user and the class must be existing in the system to use this function.  

• This method is more commonly used when students were not yet placed in a 

class or need to be added to another class later on.  

• Students can also be added to a class at creation in their user profile or using 

an import file.  

 

Remove Student from Class 

To remove a student from a class: In the Class Functions Menu, select the Remove 

Student from Class link  
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The Delete Student from Class form appears. 

 

• Type the student ID or use the Browse buttons to select the Student ID from a list  

• Type the class code or use the Browse buttons to select the class from a list 

• Select OK to save the changes to the system.  

• Repeat this procedure for each student to wish to delete from that class.  

 

  NOTE 

Students can also be deleted from a class from their user profile or using an 

import file.  

 

List Students in Class 

To obtain a list of all the students (and instructors) who belong to a specific class:  

 

Select List Students In class from the Class Functions Menu.  
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Type the class code or use the Down Arrow at the right of the field to find the class code. 

 

The list of the users belonging to this class, including the instructor(s), will display. 

 

 

NOTE:  

If the instructor’s name is not listed under Student Name but is listed above 

beside Instructor, this means the instructor created the class or the class was 

created for that instructor; however, the instructor does not belong to the class. 

 

Once displayed, this list can be saved in .txt or .csv format.  

 

• Select File > Save in the interface top menu.  

• In the SAVE AS window, type the file's name and select the file format, then 

click on the Save button 
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Delete Class 

 

• In the Class Functions Menu, select the Delete Entire Class link  

• Use the Select buttons to find the class code or simply type the class code in the 

required field.  

 

• Select OK at the prompt to confirm the deletion.  
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NOTE: 

Deleting a class does not delete the students belonging to that class from the 

system, it only removes any links and menu restrictions the students had while in 

that class. 

 

Registration Functions 

When newly delivered, the system comes with one pre-registered user ID only: 

MASTER.  

 

This is the system supervisor's ID. The default password is PWORD and should be 

changed at the first login.  

 

All other users will have to be registered according to the site's requirements and policies.  
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Registration functions are available from the System Supervisor menu and from the 

instructor menu. However, these functions behave slightly differently depending if they 

are accessed with System Supervisor ID or with instructor privileges.  

 

As we progress through each of these functions, the differences will be emphasized.  

Registering Users 

• The System Supervisor can only create Instructor IDs via the system's 

REGISTER USER command.  

• Only Instructors can create Student IDs via the register user internal function. 

 

 WARNING:  

The only way for the System Supervisor to register a student is via an IMPORT 

FILE.  

It's important to understand that although the System Supervisor can change an 

instructor menu tag to STUD, thus restricting the displayed menu of the user to 

the student's menu, this new user will keep full instructor's privileges and can 

Plan, Track, author, register and delete students and their records.  

 

Registering an Instructor 

Instructors can only be registered by the system Administrator (MASTER), either using 

the internal CAN-8 function Register a User from the Master menu, or by using an 

Import Registration file. 

 

To create an instructor using the CAN-8 internal function:  
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• Sign in with the MASTER ID  

• Locate and expand the Registration Functions menu entry as illustrated, then 

select Register a User.  

• The user registration form will display.  

There are 3 tabs to that form. Each requiring specific information:  

The General Information tab: 

 

• The User ID Code is the identification code that the Instructor signs on with. It 

must be unique within the system.  

Any alphanumeric combination with a maximum of 18 characters is supported. 

Punctuation and symbols are not accepted. The space character will be ignored. 

Once the registration is done, it cannot be edited.  

• The User Name is the Instructor's name.  

A maximum of 30 characters is supported. This field will accept alphanumeric 

characters, punctuation, spaces and symbols. Although this field can be edited, it 

is a mandatory field. You cannot leave it blank.  

• The User Password is the password to be used for the user to sign on.  

it is prefilled with the default PWORD and the user may change it at any time 

using the Change Password option in their menu or it can be changed when 

creating the user.  

A maximum of 8 characters, alphanumeric only, is supported for this field. The 

password does not display when being changed or entered. This field can be left 

blank by deleting the existing password. If a user loses or forgets his/her 

password, this is the only place it can be reset.  
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• The Initial Menu is the starting point of the user in the menu system. The default 

for Instructors is called INST. If left as is, the instructors signing in will see the 

entire instructor's menu layout.  

As seen in the Creating a Submenu section of this chapter, menus may be created 

by the System supervisor on a site-specific basis. If the System Supervisor creates 

a menu, then assigns the new menu code to the instructor's profile in the Initial 

menu field, the instructor will only be able to access that menu instead of the 

entire instructors' default menu.  

• The Classes field specifies which classes the instructor belongs to. Each user can 

belong to a maximum of 16 classes. Each of the classes is listed by class code in 

the form. The classes must have been created prior to enrolling a user in it. The 

class attributes will override the attributes assigned to the Instructor's profile. In 

the event a user belongs to more than one class, the user will receive the attributes 

of the first (top) class listed in that section. If the attributes of that are too 

restrictive for the instructors, the System Supervisor can create a class reserved 

for instructors, which would then give them the appropriate attributes, and list it 

first in their profile.  

Registering an Instructor in a class will facilitate student's monitoring as it allows 

the instructor to use the View by Class option in the Tracker.  

The Attributes tab 

 

The Code and Description fields are pre-filled with all of the system-defined attributes. 

These attributes have been setup by the MASTER user at some earlier point in the 

operation of the system.  
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By default, all existing attributes are selected.  

 

The System Supervisor should uncheck the attribute(s) that should not be assigned to the 

Instructor.  

 

The Instructor will see only menu entries that have been assigned one of these attributes.  

 

For more information about System Attributes and how to use them to customize menu 

displays, please refer to the About Attributes section of this chapter.  

The Settings tab 

The default settings shown in the tab are inherited from the System supervisor. However, 

they can all be changed if desired.  

 

• The Interface Language  

Use the drop-down arrow at the end of this field to select what language is used 

for the instructors' interface. The top menu and the messages will be in the 

language chosen.  

• Change Image.  

By default, the image assigned to the system supervisor's background is also 

assigned to the instructors and will show there. It can be removed or changed.  

When the Change Image button is selected, a choice of several images 

previously entered in the system will display. Only the system supervisor can add 

images.  
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The background image is displayed over the system's main interface for that user. 

It is not displayed in the lesson background.  

To select the user's background image, simply click on the image of your choice. 

The image selected will show in the Screen Background section of the form. If 

there is no image available in the selector, contact your system administrator to 

load the image of your choice. If no image is selected, the default interface 

background will show when the user signs in.  

• Inactivity Timeout.  

When a user is signed in, one license out of the available pool of licenses 

available to the site is being used. If the user signs in, but forgets to sign out, that 

license is being held and cannot be used by anyone else until it is released and 

returned to the license pool. 

 

The Inactivity timeout settings prevent licenses from being held indefinitely by a user 

who forgot to log out.  

If the Inactivity Timeout is set to 15 min, a count-down starts when the software no 

longer detects ANY activity in the CAN-8 client (ie: no mouse clicks/audio played/etc). 

After 15 min, the user's session is automatically logged out and the license returned to the 

license pool. The work in progress will be saved before the session is terminated.  

To display all timeout options, click on the down arrow at the right of the Inactivity 

Timeout field, as illustrated. The choices range between Never (no timeout ever) and 3 

hours and 45 minutes. Select the time that seems most appropriate by clicking on it.  

The default setting is Never, meaning the user can keep the license as long as they are 

signed on. There is no way to force a disconnection other that restarting the service.  
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30 seconds before disconnection, a warning message appears on the user's screen. If the 

user clicks on the button, the session is kept open on that station. The warning will appear 

again if the session becomes inactive for the specified time. The user on the client station 

cannot change this setting.  

 

• Maximum tabs  

 

Sets the maximum number of simultaneous lesson tabs a user can open at the same time. 

The default number is 7. 

If 1 is selected, the instructor will only be able to open one tab with one function (Player, 

Planner, Tracker, reports, student list etc...) at a time. If 7 is selected, the instructor can 

have up to 7 functions opened simultaneously.  

 

 

If the instructor exceeds the tab limit defined in the profile, this warning message will 

appear.  
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• Instructors Options  

 

These options allow you to customize the access to the CAN-8 main functions on a per 

user basis. You can for example allow a user to evaluate the student's answers but restrict 

that user from editing lessons. You can select any combination.  

o Change Plan  

This option is selected by default. Deselect it to prevent the instructor 

from editing existing lessons. (The Planner will open but no changes can 

be applied)  

o Delete Tracker Data  

This option is selected by default  

Deselect it to prevent the instructor to delete the recorded data or the 

student list from Trackers.  

o Student Registration Controls  

This option is selected by default  

If it is deselected, this instructor will not be able to register any student in 

the system.  

o Enable Test in Tracker  

This option is selected by default  

If it is deselected, this instructor will not be able to change the mode of the 

lessons.  

 

  NOTE 

The Create a User form can also be accessed by selecting FILE > Create > 

Student. Removing the Register User link from the Instructors' menu is therefore 

not enough to prevent instructors from registering students. It should be restricted 

from their profile using the student Registration Controls option.  

 

 

 



 

45 

 

Registering a Student 

Students can only be registered by instructors using the internal function link (Register 

User in the main menu. 

 

The information below is only applicable for users signed in with an instructor ID.  

  NOTE 

Your ID may have been restricted by the system supervisor to prevent user 

registration. When following the steps below, you will receive a message advising 

you that these steps cannot be completed due to your profile restriction.  

 

The procedure below is mostly similar to the procedure to register an Instructor. Some 

options however will vary. 

 

• Sign in with an Instructor ID  

• Locate and expand the Registration Functions menu entry as illustrated, then 

select Register a User.  

• The user registration form will display.  

There are 3 tabs to that form. Each requiring specific information:  
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The General Information tab 

 

• The User ID Code is the identification code that the student will sign in with. It 

must be unique within the system.  

Any alphanumeric combination with a maximum of 18 characters is supported. 

Punctuation and symbols are not accepted. The space character will be ignored. 

Once the registration is done, it cannot be edited.  

• The User Name is the student's name or reference number in your organization.  

A maximum of 30 characters is supported. This field will accept alphanumeric 

characters, punctuation, spaces and symbols. Although this field can be edited, it 

is a mandatory field. You cannot leave it blank.  

• The User Password is the password assigned to that user.  

it is prefilled with the default PWORD and the student may change it at any time 

using the Change Password option in their menu or it can be changed when 

creating the user.  

A maximum of 8 characters, alphanumeric only, is supported for this field. The 

password does not display when being changed or entered. This field can be left 

blank by deleting the existing password. If a user loses or forgets his/her 

password, this is the only place it can be reset.  

• The Initial Menu is the starting point of the user in the menu system. The default 

for Students is called STUD and is pre-filled. If left as is, the instructors signing 

in will see the entire student menu layout.  

As seen in the Creating a Submenu section of this chapter, menus may be created 

by the System supervisor on a site-specific basis. If the System Supervisor creates 

a new menu, and you assign the new code to the student's profile in the Initial 



 

47 

 

menu field, the student will only be able to access that submenu instead of the 

entire student default menu.  

• The Classes section specifies which classes the students will belong to. Each user 

can belong to a maximum of 16 classes. Each class must be listed by class code in 

the form. The class(es) must have been created prior to enrolling a user in it. The 

class' attributes will override the attributes assigned to the students' profile. In 

the event a user belongs to more than one class, the user will receive the attributes 

of the first (top) class listed in that section.  

Placing students in a class will allow the instructor to use the View by Class 

option in the Tracker to simplify the display.  

  NOTE 

Classes are inherited from the instructor's profile. If the instructor belongs to one 

or more class(es), that section will be pre-filled with the same class(es). The class 

that does not apply can be removed.  

 

The Attributes tab 

 

The Code and Description fields are pre-filled with all of the system-defined attributes. 

These attributes have been setup by the System supervisor at some earlier point in the 

operation of the system. 
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  NOTE 

Attributes in the students' profiles are inherited from the instructors. The 

instructors can restrict them more but cannot assign attributes that are not in their 

own profiles. The select button for these attributes will be greyed out.  

 

The students will only see menu entries with matching attributes.  

 

For more information about System Attributes and how to use them to customize menu 

displays, please refer to the About Attributes section of this chapter.  

The Settings tab 

  NOTE 

The default settings shown in the tab are inherited from the instructor. However, 

they can all be changed if desired.  

 

 

•  Interface Language  

Use the drop-down arrow at the end of this field to select what language is used 
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for the student's interface. The top menu and the messages will be in the language 

chosen.  

• Change Image.  

By default, the image assigned to the instructor's background is also assigned to 

the students' and will show there. It can be changed.  

When the Change Image button is selected, a choice of several images 

previously entered in the system will display. Only the system supervisor can add 

images.  

 

The background image is displayed over the system's main interface only. It is not 

displayed in the lesson background.  

To select the user's background image, simply click on the image of your choice. 

The image selected will show in the Screen Background section of the form. If no 

image is selected, the default interface background will show when the user signs 

in.  

• Inactivity Timeout.  

 

  NOTE 

This setting is inherited from the instructor. However, it can be changed if 

desired.  

 

When a user is signed in, one license out of the available pool of licenses available to the 

site is being used. If the user signs in, but forgets to sign out, that license is being held 

and cannot be used by anyone else until it is released and returned to the license pool. 

 

The Inactivity timeout settings prevent licenses from being held indefinitely by a user 

who forgot to log out.  

If the Inactivity Timeout is set to 15 min, a count-down starts when the software no 

longer detects ANY activity in the CAN-8 client (ie: no mouse clicks/audio played/etc). 

After 15 min, the user's session is automatically logged out and the license returned to the 

license pool. The work in progress will be saved before the session is terminated.  
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To display all timeout options, click on the down arrow at the right of the Inactivity 

Timeout field, as illustrated. The choices range between Never (no timeout ever) and 3 

hours and 45 minutes. Select the time that seems most appropriate by clicking on it.  

The default setting is Never, meaning the user can keep the license as long as they are 

signed on. There is no way to force a disconnection other that restarting the service.  

 

30 seconds before disconnection, a warning message appears on the user's screen. If the 

user clicks on the button, the session is kept open on that station. The warning will appear 

again if the session becomes inactive for the specified time. The user on the client station 

cannot change this setting.  

• Maximum tabs  

  NOTE 

This setting is inherited from the instructor's ID but can be changed 

.  

 

Sets the maximum number of simultaneous lesson tabs a user can open at the same time. 

The default number is 7. 

If 1 is selected, the student will only be able to open one lesson at a time and must close it 

before starting another one. If the default (7) is kept, the student can have up to 7 lessons 

opened simultaneously.  

If the student exceeds the tab limit defined in the profile, this warning message will 

appear.  
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  NOTE 

The Create a User form can also be accessed by selecting FILE > Create > User 

from the top menu bar.  

 

Delete a User 

This function will permanently remove a user ID and all associated records and recorded 

data for the user from the system.  

 

  NOTES 

• Whereas an ID can be deleted, and an identical ID recreated, the data associated 

with the deleted ID cannot be recovered by recreating the same ID.  

• The system supervisor can remove any student and instructor ID from the system  

• Instructors can only delete IDs of students they have registered themselves.  

• Instructors cannot delete students who belong to other instructors.  

• Instructors cannot delete another Instructor ID  

 

The user deletion procedure is as follow:  

• sign in with the system supervisor ID to delete students or an instructor ID, with 

your instructor ID to delete a student you have registered.  

• In Registration Functions select Delete User.  
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• In the dialog box enter the User ID to delete, or press Select and click on the user 

ID in the list of users available then OK to confirm the deletion.  

 

  NOTE 

The Delete a User form can also be accessed by selecting FILE from the menu 

bar and the option DELETE then User From System.  

 

Students can also be deleted via an import file.  

 

Change a User 

Use the Change a User function to modify the settings of a user profile.  

• sign in with the system supervisor ID to change student or instructor IDs, with 

your instructor ID to change the information of a student you have registered.  

• From Registration Functions, select Change User.  

 

• Enter the User ID you want to edit, or press Select and click on the user ID in the 

list of users available then OK to confirm the selection.  
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The User Properties form containing the user's settings is displayed with the pre-filled 

information. 

• All fields (including the Settings and Attributes tabs' fields) of this form may be 

changed except for the user ID code.  

• The password in the Password field is never visible. If a password has been 

forgotten, it cannot be retrieved by looking at the Users Properties; instead the 

password must be replaced by typing a new one in that field.  

 

 

  NOTE 

The Change a User form can also be accessed by selecting Edit from the menu 

bar and the option User.  

 

User profiles can also be modified using an import file.  

 

Display User List 

You can display a partial or full list of the system users.  

 

The Display User List function behaves slightly differently if accessed by an instructor 

rather than by the System Supervisor (signed in with Master ID).  

From the System Supervisor ID 

 



 

54 

 

The System Supervisor can bring up a list of all the system users. When selecting 

DISPLAY USER LIST, the System Supervisor can choose to display the instructors only, 

or both, Instructors and Students.  

 
 

Click on the option desired then select OK. 

 

From the Instructor ID 

Instructors can only display students therefore do not see the Select User List dialog 

when selecting Display User List.  

 

Furthermore, instructors can only display the list of students they themselves have 

registered. If the instructor has not registered any users, a message will display as 

illustrated.  

 

 

User Display List 
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The information shown in the display user list is the same for both types of IDs.  

 

The user list shows 4 different fields:  

• User name  

Information entered in the User Name field of the registration form.  

• User ID  

User ID associated with the user's name.  

• Initial Menu  

Lists the menu the user will be shown when signing in.  

• User Serial Number  

A serial number is assigned to any ID when it is created. This number is unique. 

As users are created, the serial number increase.  

When a REFRESH ALL is done, these numbers are reset and the numbers will 

start again from one.  

User data folders on the server are created with these serial numbers to identify 

the answers in a unique way.  

Click on any of the column header bars to view the list in order (either 

alphabetical or numeric)  

Saving the User List 

This list can be saved in .txt or .csv format.  

Select File > Save in the interface top menu. In the SAVE AS window, type the file's 

name and select the file format, then click on the Save button.  

 

 

VI - Activity Reports 

It is possible to generate reports to follow up on the users' activities in the system and the 

time spent in the system. These reports can help resolve certain issues such as missing 

students' recordings by confirming if they entered an activity, the time and location they 

accessed it from, and the time spent. It also gives information such as total time spent in 

the system for record keeping.  
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Report Functions 

You can generate 2 types of reports: A Detailed report and a Summary Reports  

 

Instructors and the system supervisor can generate these reports; however, whereas the 

system administrator can generate a report for all system users, including the system 

supervisor, instructors can only generate a report for the students they have registered 

themselves  

 

The Reports menu is by default present in both the system administrator's and the 

instructors' menu.  

 

SUMMARY REPORT and DETAILED REPORT are Internal functions and can be 

added or removed from any menu at the organization's discretion.  

 

Detailed vs Summary Student Progress Reports 

• The Detailed Report provides information on a sessions-by-session basis and 

includes dates and times of user login, IP address, and what actions the user took 

during that session.  

 

Each selected menu item is recorded along with the time the user spent on it. At 

each login the report shows the session total elapsed time, along with a duration 

for each lesson item selected by the user.  

 

This report is suitable to trace user activities and to determine where the students 

spend the most time. It is also helpful as a tool to diagnose unusual activities such 

as the registration of unknown users and other system level changes.  

• The Summary Report provides only a total of time spent by users in the system. 

It also includes their last login date. This function is more suited to creation of 

reports regarding student attendance and if they have spent enough time on the 

system to complete the assigned work.  

 

Creating a Report 

Both types of reports can be generated  

• Per class  

• Per user  

• for a specific date  

• for the time frame of your choice  
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Step 1: Select a Report 

To generate a report, Open the Reports menu then select the option of your choice: 

Detailed Report or Summary Report  

 

Step 2: Report Options 

A report option window will open. There is a slight difference between the options 

available if you are signed in with the system supervisor ID or with the instructor's ID 

due to the fact that the system supervisor can do a report for instructors and students, 

whereas instructor can only generate reports for students. 

System supervisor's options  

 

Instructors' options  
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• The Date fields. 

These Date fields are optional.  

o If you do not enter a start and end date, the report will start from the last 

system refresh (or the installation of the CAN-8 system on the site) and 

end at the current date.  

o If you enter a start date but no end date, the report will be issued from the 

date given to the current date and time.  

o If you enter an end date but no start date, the report is created from the 

first records available on the system, until midnight of the end date given.  

o Finally, if you enter a start date and an end date, the report shows activities 

that took place on the system from the start date at 12:01AM to the end 

date at midnight.  

The date format, for these fields, is YYYYMMDD Where YYYY is the year, MM is the 

month and DD is the day. There is no space in the date field, only digits. For example, 

March 8, 2010 would be represented as 20100308 in the date fields.  

 

  NOTE 

 

For same day activity reports, enter identical dates in the Start Date and End Date 

fields. 

• The FOR Section 

It offers three options:  

1. All 

Users 

Owned. 

Instructors will obtain a detailed report of the activities of all the users that were 

created under the ID they signed in with.  

 

Since the system administrator only creates instructors, the report will show the 

activities of all the instructors during the time frame specified in the DATE fields. 

• If you signed in as MASTER, the option Show Students Also can be 

selected. The report will show all activities recorded for the instructors and 

the students in an alphabetical order.  

• If the option Report by Class is also selected, as above, the instructors 

and the students' records will be listed, but by classes instead of 

alphabetical order.  

  NOTE: 

Instructors do not see the options Show Students Also and Report by 

Classes in the Report Options Window since they can only display the 

records of the users they have created themselves.  
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2. User Either enter the User ID in the User field or select Browse and choose a User ID 

from the user list. The report will show the activities from that user only, and for 

the time frame specified in the date fields or from their first entry recorded in the 

system if no dates were specified.  

  NOTES 

• The System Supervisor can type in any user code in that field, student or 

instructor.  

• An instructor can only type the code of the students they created 

themselves. The browse button will display the list of available IDs the 

report can be made for.  

 

3. Class To view a class report, or activities recorded for users belonging to a specific class 

(including the instructor), select Class, enter the class code or click on Browse to 

select a class from the class list.  

NOTES  

• The System Supervisor can type in any class code in that field and will 

have a report of all the users belonging to that class.  

• An instructor who does not belong to any class can select any class that 

exists in the system and view its students, even if the students were 

registered by another instructor.  

• Instructors who belong to one or more classes will only be able to view 

reports for the classes they belong to.  

Step 3: Report Generation 

 

Depending on the date frame entered and the number of activities recorded on the system 

for that period, the report can take several minutes before being displayed.  
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Step 4: Reading the Report 

Reading Detailed Reports 

The report is displayed in the Detailed Student Progress report window. The user can 

use the scroll bar on the right side of that window to show data that cannot be displayed.  

 

The report is divided in columns. There are 4 headers in the top bar; each header 

corresponds to a column. each displaying a specific type of information.  

Start Time Type Activity Elapsed Time 

Gives the 

absolute 

system time 

at which the 

action took 

place 

Indicates that the action 

described in the 

Activity column was a 

system function 

executed by either an 

instructor or the system 

administrator  

This column will only 

display INST or 

Master. If the action is 

not a system function, it 

will not display 

anything.  

Describes 

the action 

taken by the 

users in the 

menu 

Gives the time of the action 

relative to the starting time 

and the total session duration 

at the end. 

Most of the information is in the Activity column.  

 

The reports can display the activity records of several users, therefore the first lines in the 

activity column always indicate:  
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• the name and user Id of the person whose records are being displayed.  

• the start date of the records that will follow.  

• the IP address of the station the user was signed on, and the time at which the 

CAN-8 session was started. 

If a report is done for a period over several days, and the user has been active in the 

system on different dates during that period, the Activity report for that user will show 

the login date followed by the activities, then the next login date, and the corresponding 

activities. The name and user ID are not repeated. 

 

  NOTE 

If the report lists the activities for several users, the users are sorted alphabetically 

by name. To sort by date, create a new report using the Date Start and Date End 

fields.  

 

Activity details 

After the User information comes the activity details.  

The table below lists the entries you can find in a report and a short description for each. 

Entry Description Applies to 

System 

Admin 

Instructor Student 

Name: Julie 

Breton User 

ID: Jbret 

No Activity 

records stored 

for that user 

The user Julie Breton did not 

sign in CAN-8 during the time 

period specified in the report 

   

Logout  

Total Session 

Duration: 

00:04:35 

The user signed of CAN-8. The 

duration of this session was 

4min 35 sec. 

   

MENU: 

MASTER 

Menu  

Accessed master menu. This 

person was signed in with the 

MASTER ID. 

 
X X 

MENU: 

INSTRUCTOR 

Main Menu  

Accessed the Instructor's menu.  
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MENU: 

STUDENT 

Main Menu  

Accessed the Student's menu.  
   

MENU: 

STUDENT 

Main Menu 

ITEM: 

Chapter 9  

Accessed the Student's menu. 

Entered the lesson titled 

"Chapter 9" as a student.  

   

Create Menu 

Item (Serial 

142): ESL 

Level 1 

Submenu: 

ESL1 

The First line shows a menu 

creation record, the title ESL 

Level 1 and the serial number 

for the item created. This serial 

number will be referred to again 

if and when the menu entry is 

deleted. 

 

The second line shows the item 

type (Submenu in this case) and 

the MENU TAG (ESL1)  

 
X X 

Delete Menu 

Item: Item 

Name Not 

Available 

(Serial 00003) 

The menu item that was 

assigned the serial number 3 

was deleted.  

 
X X 

Create Menu 

Item (Serial 1): 

ESL Level 1 - 

Part 1 

EAASY - Item 

Path: 

SVI\ESL11 

This is also a menu entry 

creation record. The first line 

shows the same type of 

information as above: Serial 

number and title. 

 

The second line shows the item 

type (EAASY) and the path 

assigned to the lesson. 

 
X X 

MENU: User 

Registration 

Menu 

ITEM: 

Register a User 

Create User: 

JR1234 Name: 

Royo, 

Jacqueline 

User created. ID and name are 

shown below. If this line is 

found under the system admin 

records, the user created is an 

instructor. If this line is part of 

an instructor's record, the user 

created is a student.  

  
X 
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INSTRUCTOR 

ITEM: 

Chapter 9 

Accessed a menu item (chapter 

9) through a function that 

requires instructor's privileges, 

like the Planner or the Tracker. 

  
X 

MENU: Report 

Functions 

Display 

Detailed 

Student 

Progress 

Report 

Created a detailed progress 

report 

  
X 

Modify User: 

MASTER - 

System 

Supervisor 

The System Supervisor's 

changed his profile's settings 

   

Modify User: 

JR1234 - Royo 

Jacqueline 

Changes were made to the 

profile settings of the user 

mentioned 

  
X 

MENU: User 

Registration 

Menu  

ITEM: Display 

user list 

Entered the User Registration 

menu and selected the display 

user list function  

  
X 

ITEM: Edit 

system 

attributes 

Modified the system Attributes. 

(Added, removed, or modified)  

 
X X 

Reading Summary Reports 

 

The report is displayed in the Summary Student Progress Report window. The user 

can use the scroll bar on the right side of that window to show data that cannot be 

displayed.  
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The header bar divides the report in columns. There are 3 headers; each specifies the 

content of the column below.  

User Name Date Last Used Total Time Logged In 

Users' names, 

listed in 

alphabetical 

order 

Displays either:  

• The date the user last used 

the CAN-8 system  

• Has Not Used System if 

the user is registered yet  

o has not used the 

system during the 

date frame selected 

in the report 

window.  

o never signed in 

CAN-8 since the 

ID's creation if no 

time frame was 

entered.  

Gives the total time of all recorded 

sessions for that user since the user 

ID's creation.  

 

The time displayed is in the format 

HH:MM:SS 

Step 5: Saving the Reports  

It may be important to save the report to a file for later use. To do so, once the report is 

displayed   

• select FILE > SAVE in the top menu bar.  

• select the folder you wish to save the report in, then enter the name and extension 

of the file (.txt)  
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• Once the report is saved locally as a text file, you can open it with the editor of 

your choice to view or print.  

VII - Importing Registration 

The System Supervisor can set up an import file to create multiple registrations at once 

instead of registering them manually.  

Since the 20150929 version of CAN-8, instructors can also import their students' 

registrations. The system supervisor would have to create a link to the import function in 

the Instructors menu. 

Overview 

With an import file, the system supervisor can:  

• Register, edit, or delete students  

• Register, edit or delete instructors.  

• Create or delete classes  

• Refresh the system of all users and their data.  

• Reset the users and classes database to their original state.  

The import process requires a specially formatted import file, which can be created with:  

• a regular text editor (like Notepad),  

• a spreadsheet program and saved as a tab separated txt file.  

• an output from a database,  

• a specialized program created to extract data from the institutions' database.  

The file must be entirely in ASCII with the field delimiters used as described:  

• All fields must be delimited by tabs.  

• Each line must be terminated with a carriage-return (or linefeed)  

• For optional fields, a space holder must be placed to preserve the structure of the 

file.  

• The output file must be in .txt format  

 

When the importation process is done, a log file, (xxx.rep) is created in the same folder 

the import.txt file is located in. The report file contains details of the import process, 

successful registrations, warnings, and registration errors. This topic will be further 

discussed.  

 

The import file can be created in several sections each starting with a different header 

followed by as many registration lines as necessary (one per class or user created). 

Alternately, several files can be generated, one to create classes, one for students, one for 

instructors, and another one for the system refresh, or all the above files can be 
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condensed into one file only that will do all the different sections in sequence.  

 

Each header will define to the system what to do with the lines below, and depending on 

the header, the following lines will have to be formatted accordingly.  

 

The order in which the [headers] are placed in the file matters. The file is read by the 

server and the registration generated from top to bottom. Therefore, any deletions should 

come first, followed by class creation, instructor creation, and finally student creation.  

If the order is incorrect, the import process will generate warnings and error. For 

instance, a student cannot be placed in a class if the class has not been created first. 

Equally the student cannot be assigned to an instructor if the instructor has not yet been 

created.  

Import file format 

  NOTES 

• It is necessary to preserve the format of each line or the import will fail.  

• Each field has specific data requirements. Some fields are mandatory, some are 

optional. Optional fields must be filled with a space holder to preserve the 

line's format or the import will fail.  

• There are 2 formats available for the lines:  

o a simple format, which creates users with all default values.  

o a detailed format which allows you to specify the value of each setting in 

the profiles.  

Both are detailed in the table below.  

... 

Sample Import File 

An import file is composed of  

• a [header] in square brackets  

• followed by 1 line per registration in the format required  

• no empty line  

• Line can be entered multiple times to edit the user. i.e. if the user belongs to 

several classes, you will need one line per class for the same user.  

   

  NOTES 

Empty lines will report an error  

Doubled lines will report a warning. You can ignore these. 

Both reports will show in the import rep file.  
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The sample file below has been commented out and empty lines have been added for 

clarity. These lines would not be present in an import file.  

 

Lines and Fields Format 

The CLASS CREATION SECTION  

Section header: 

[CLASSES] 

mandatory field 

Must be spelled exactly like this and placed between square brackets, then followed by a 

carriage return  

Line format: 

CODE [t] CLASS NAME [t] INSTID [t] TERM [t] ATT ADD [t] ATT REMOVE 

[carriage return]  

Field format:  

1. CODE: 

mandatory field 

Class code, minimum 1 character, maximum length 8 characters 

2. CLASS NAME: 

Mandatory field  

Min. length 1 character, max. length 40 characters, alphanumeric, punctuation and 

symbols accepted  

3. INSTID: 

Optional field 

Instructor User ID code that has been previously registered. Alphanumeric only. 

Can be replaced by a *  
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4. TERM:  

Optional field. 

Term information field, maximum length 8 characters. Can be replaced by a * or a 

[sp]  

5. ATT ADD: 

Mandatory field  

Class attributes. Attributes must exist in system. The attributes placed in this field 

will be added to the users belonging to that class. You can place the space holders 

* or [sp]  

6. ATT REMOVE:  

optional field  

Class Attributes, maximum length 16 characters. These attributes MUST exist in 

the system. The attributes placed in this field will be removed from the profile of 

the users placed in that class. If no attribute should be removed, enter the [cr] * or 

[sp] to indicate the end of the line. It is not necessary to enter a space holder 

character.  

7. [t] 

Mandatory field 

Tab character. (Code 0x09 in the ASCII table.) A tab character must be inserted 

between each field or the import will fail.  

8. [CR]: 

Mandatory 

[Carriage Return] Or Enter key on the keyboard. Must be inserted at the end of 

each line to indicate the end of the information for this  

9. [SP] and *; 

optional field  

Space bar key or * character. Both can be used as space holders for optional 

fields. They must be present and must be preceded and followed by a tab 

character.  

SAMPLE [CLASSES] SECTION 

[CLASSES]  

ESL01      English, level 1       JSMITH       fall       E1     F2  

FRE02      French, level 2       MDUPONT      *       F2     E1 

 

  NOTES 

• If using copy/paste to create your import file, please note that the carriage returns 

are lost in the process. 

A carriage return must be manually added at the end of each line that has been 

pasted.  

• The Code and Class Name fields are mandatory fields and must include at least 

one alphanumeric character.  

• The content of the ATT fields can be left undefined, in which case this class will 

not add nor remove any attributes from the users’ profiles. * (SHIFT +8 on a 

qwerty keyboard) can be used as a space holder for visual help when creating the 

file.  
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The INSTRUCTORS' SECTION 

 

Section Header 

[INST] 

Mandatory  

Must be placed between [square brackets] and followed by a carriage return. Spelling 

must be respected.  

 

Line format 

 

Simple format: 

INSTID [t] NAME [t] PASS [t] ATT [t][CLASS] [t] [cr]  

 

Detailed format:  

INSTID [t] NAME [t] PASS [t] <+/-> ATT [t] & [t] MENU [t] INACT [t] MAXTAB [t] 

BACKGROUND-NUM [t] LANG [t] CAPS [t] CLASS [cr]  

 

Field format:  

1. INSTID:  

Mandatory field  

The user ID to be created/modified (max 18 alphanumeric characters. Punctuation not 

accepted.)  

2. NAME: 

Mandatory field 

Instructor's name (Min 1 char, Max 30 chars). This field will accept alphanumeric 

characters, punctuation, spaces and symbols.  

3. PASS: 

Mandatory field 

to create a blank password (user signs in without password), a [sp] character must be 

entered in that field. It must be preceded and followed by a tab character.  

4. ATT: 

Mandatory field 

Attributes to assign to the user (Max 16) These attributes must exist in the system.  

<+/-> These characters are optional and used when editing users' settings via an 

import file.  

 

-WHEN CREATING USERS:  

o  

If in the ATT field you enter one of the following characters: +, -, [sp] or one 

of the sequences +* or +[sp], the user will be created without attributes. This 

user will need to be placed in a class that adds attributes.  

o To create a user with attributes, enter the attributes you want to give them. 

(maximum 16 in this field) (e.g. enter AB in this field to give it attributes A 

and B)  
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- When EDITING AN EXISTING USER  

o To add one or more attributes to those already in the user’s profile, enter 

the + character followed directly by the attribute. (+AB adds these 2 attributes 

to the previous ones)  

o To replace all the attributes with different attributes, enter the new 

attribute(s). (ex: If the user had only A1, enter B2 in this field to remove A1 

and add B2.)  

o To remove one or more attributes from the user's profile, use the character - 

followed directly by the attribute(s) to remove (e.g. if the user has ABC, type -

B to remove this attribute)  

o If you want to leave this user's attributes unchanged, type +[SP]  

o To remove all attributes from this user, type a space character [sp] in this 

field.  

o <+/-> are only valid if using the detailed import format  

Note: you cannot use the +A-B sequence or you will get an error. You will need 

to create 2 lines, one with +A, one with -B  

5. The & character: 

Mandatory field. 

It is a format flag and must be present. It differentiates the detailed line format from 

the simple format  

6. MENU: 

Mandatory field 

Initial Menu for the instructor. Type in:  

o INST for the default instructor menu.  

o The menu tag of a submenu to restrict access to that submenu.  

7. INACT: 

Mandatory field 

Sets the inactivity timeout. You must type at least one digit. Accepted Values range 

from 0 (no time out) to 195 (3 hours 15 min maximum timeout allowed)  

The time is rounded up to the nearest 15-minute interval. From 1 to 15, timeout it is 

rounded up to 15 min. From 16 to 30, it is rounded to 30 min, etc...  

Numbers greater than 195 will be defaulted to 195. Non numeric characters will 

generate an error.  

8. MAXTAB: 

Mandatory field 

Sets the Maximum number of tabs in the main interface allowed to be open at one 

time  

Only digit from 1 to 7 can be entered. 0 will be defaulted to 1, and all numbers greater 

than 7 will be defaulted to 7. Non-numeric characters will result in an error during the 

import.  

9. BACKGROUND-NUM: 

Mandatory field 



 

71 

 

This field takes numeric characters only and must contain at least one. Enter the 

number of the background image shown on the background selector screen.  

o 0 gives CAN-8 default background.  

o Numbers non-attributed to any image will default to the CAN-8 background.  

o Any other non-numeric character will result in an error during import.  

10. LANG: 

Mandatory field 

Sets the interface language; use one of the following 2-letter codes  

o EN - English (default)  

o FR - French  

o SP - Spanish  

11. CAP: 

Mandatory field 

Only accepted characters are P, T, R, C and [sp] where each letter enables one of the 

following instructor functions:  

o P - Enables changes in Planner  

o T - Enables delete in Tracker  

o R - Enables registration controls (create/change/delete) on students  

o C - Enables start/stop test in Tracker  

You can enter a combination of any number of the above letters,  

If the ID created should have none of these functions enabled in the profile, 

then a space [sp] or a * (star character) should be typed in to keep the file format 

valid.  

12. CLASS: 

Optional field 

A class would have to be created first in order to use this field. If the user does not 

need to be placed in a class, this field can be simply ignored. There is no need to enter 

a [sp] character. Simply enter a [cr] after the CAP field.  

 

  NOTE  

You can also use this field to remove users from classes. Place the "-"character in 

front of the class code. You need to create 1 line per class to delete from the user's 

profile.  

13. The [t]: 

Mandatory 

Tab character. (Code 0x09 in the ASCII table.) Must be present between fields to 

preserve the file format.  

14. The [sp] or * characters:  

Optional 

Space key on the keyboard or * (star character). They are necessary in all optional 

fields when no data is desired to keep the file format, except in the CLASS field 

which can be ignored.  

15. [cr] 

Mandatory 

16. Carriage return or Enter key on the keyboard. Indicate the end of the line.  
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SAMPLE [INST] SECTION 

 

[INST] 

 

Jane     smith Jane     pword     abcefg     &     inst     0     7     0     en     Ptrc  

Liane     Dupont, Liane     pword     ab     &     inst     20     3     0     en     Pt     class02  

Liane     Dupont, Liane     pword     ab     &     inst     20     3     0     en     Pt     class01  

   

  NOTES 

• [ATT] field. When editing a user, if you do not want to edit the user's attributes, 

either enter all the attributes the user already has in this field or enter +[sp]. Be 

careful not to omit the + character in front of the [sp] as this would instead reset 

the user's attributes to NONE.  

• Any import file previously created with both legacy (normal and extended) 

formats is still valid. Fields no longer in use, like Button Style or Display Style 

will be ignored. New fields such as MAXTAB will get default settings.  

• If using copy/paste to create your import file, please note that the carriage returns 

are lost in the process. 

A carriage return must be manually added at the end of each line that has been 

pasted. 

• Only the CLASS field is optional (does not require to be filled in).  

All other fields are mandatory.  

• The content of certain fields (i.e.: password) can be left empty, but in order to 

keep the file format valid, a space character [sp] must be entered, as in the PASS 

field of line 2 in the above example file.  

• If it is necessary to place the instructor in more than one class, the entire user line 

must be repeated as many times as necessary each with a different class code. 

(See line 4 in example above.)  

• If you place a character "-" directly in front of the class code, the Instructor will 

be removed from that class. If there is a space between the "-" character and the 

class name it will cause an error.  

 

The STUDENTS' SECTION  

Section header: 

 

[STUDENTS] 

Mandatory. 

Must be placed between [square brackets] and followed by a carriage return. Spelling 

must be respected.  
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Line format 

 

Simple format:  

USERID [t] NAME [t] PASS [t] ATT [t] INSTID [[t]CLASS] [cr]  

 

Detailed format: 

 

USERID [t] NAME [t] PASS [t] <+/->ATT [t] INSTID [t] & [t] MENU [t] INACT [t] 

MAXTAB [t] BACKGROUND-NUM [t] LANG [ [t] CLASS] [cr]  

 

Field format  

1. USERID: 

Mandatory field. 

Type the user ID the student will sign in with. (min 1, max 18 alphanumeric 

characters. Punctuation not accepted.)  

2. NAME: 

Mandatory field. 

Student's name or number assigned to the student in your organization (min 1, Max 

30 chars). This field will accept alphanumeric characters, punctuation, spaces and 

symbols.  

3. PASS: 

Mandatory field. 

Initial Password of user (Max 8 alphanumeric characters only). To assign a blank 

password, a [sp] character must be entered in that field.  

4. ATT: 

Mandatory field. 

Attributes to assign to the user (Max 16 attributes).  

Type here the attributes that the user should have.  

<+/->: These characters are optional and only used with attributes when editing 

existing users' settings via an import file. 

- WHEN CREATING USERS:  

o If in the ATT field you enter one of the following characters: +, -, [sp] or one 

of the sequences +* or +[sp], the user will be created without attributes. This 

user will need to be placed in a class that adds attributes.  

o To create a user with attributes, enter the attributes you want to give them. 

(maximum 16 in this field) (e.g. enter AB in this field to give it attributes A 

and B) 

        -WHEN EDITING AN EXISTING USER  

o To add one or more attributes to those already in the user's profile, enter 

the + character followed directly by the attribute. (+AB adds these 2 attributes 

to the previous ones)  
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o To replace all the attributes with different attributes, enter the new 

attribute(s). (ex: If the user had only A1, enter B2 in this field to remove A1 

and add B2.)  

o To remove one or more attributes from the user's profile, use the character -

followed directly by the attribute(s) to remove (e.g. if the user has ABC, type -

B to remove this attribute)  

o If you want to leave this user's attributes unchanged, type +[SP]  

o To remove all attributes from this user, type a space character [sp] in this 

field.  

Note: you cannot use the +A-B sequence or you will get an error. You will need 

to create 2 lines, one with +A, one with -B  

5. INSTID: 

Mandatory field. 

The ID of the instructor the student will belong to (Max 18 alphanumeric characters). 

The instructor whose ID is entered will be able to manage that student as if he/she had 

created the student manually. This ID must be valid (see NOTE below)  

6. &: 

Mandatory field. 

Format flag. It differentiates the simple file format from the detailed format. If absent, 

the line will cause an error and be discarded  

7. MENU: 

Mandatory field. 

Initial Menu for the Student. Type in:  

o STUD for the default student menu.  

o The menu tag of a submenu to restrict student access to that submenu only.  

8. INACT: 

Mandatory field. 

User timeout in minutes. Digits only ranging from 0 (no time out) to 195 (3 hours 15 

min maximum timeout allowed) . At least one digit must be entered in this field 

The time is rounded up to the nearest 15-minute interval. From 1 to 15, timeout it is 

rounded up to 15 minutes. From 16 to 30, it is rounded to 30, etc...  

Numbers greater than 195 will be defaulted to 195.  

9. MAXTAB: 

Mandatory field. 

Maximum number of tabs (lessons) the student can open at one time in the main 

interface.  

Only digit from 1 to 7 must be entered. 0 will be defaulted to 1, and all numbers 

greater than 7 will be defaulted to 7. Non-numeric characters will result in an error 

during the import. At least one digit must be entered.  

10. BACKGROUND-NUM: 

Mandatory field. 

This field takes digits only and requires at least one. Enter the number of the 

background image shown on the background selector screen.  
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o 0 gives CAN-8 default background.  

o Numbers non-attributed to any image will default to the CAN-8 background.  

o Any other non-numeric character will result in an error during import.  

11. LANG: 

Mandatory field. 

Interface language. Select one of the 2-letter codes below:  

o EN for English (default)  

o FR for French  

o SP for Spanish  

12. CLASS: 

Optional field. 

A class would have to be created first in order to use this field. If the user does not 

need to be placed in a class, this field can be simply ignored. There is no need to enter 

a [sp] character, enter a carriage return instead.  

If you are editing an existing student record, you can add a "-" character in front of 

the class code to remove the student from that class. You will need one line for each 

class to remove from the user's profile  

13. [t]: 
Mandatory field. 

ab character. (code 0x09 in the ASCII table.) You must enter a tab after each field 

except the last one or the line will cause errors and be discarded.  

14. [sp] 

Optional field. 

Space key on the keyboard. Used as space holder or when fields should remain blank.  

15. *: 

Optional. 

star character or SHIFT + 8 key on the qwerty keyboard. Used as space holder.  

16. [cr]: 

Mandatory field. 

Carriage return or Enter key on the keyboard.  

SAMPLE [STUDENTS] SECTION  

 

[students]  

CHRIS     Leandro, 

Chris     pword    +abcefg     carole     &     stud     0     7     0     EN     class01  

ALEX     Fabian, Alex     pword     -a     carole     &     stud     0     7     0     EN     class02  

XAVIER     Guillaume, 

Xavier     pword     bca     carole     &     stud     0     7     0     EN     class02  

XAVIER     Guillaume, 

Xavier     pword     bca     carole     &     stud     0     7     0     EN     class01 
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  NOTES 

• [ATT] field. When editing a user, if you do not want to delete the user's attributes, 

either enter all the attributes the user already has in this field or enter +[sp] or +*. 

Be careful not to omit the + character in front of the [sp] or the * as this would 

instead reset the user's attributes to NONE.  

• [INSTID] field. The instructor ID must be created first. If the instructor ID does 

not exist, the student will be created, but assigned to the System Supervisor. A 

warning will be shown in the import report file.  

• Any import file previously created under both legacy (normal and extended) 

formats is still valid. Fields no longer in use, like Button Style or Display Style 

will be ignored. New fields such as MAXTAB will be assigned default values.  

• If using copy/paste to create your import file, please note that the carriage returns 

are lost in the process. 

A carriage return must be manually added at the end of each line that has been 

pasted. 

• Only the CLASS field is optional (does not require to be filled in).  

All other fields are mandatory and must hold at least a [sp] or * character.  

The content of certain fields (PASS, INSTID) can be left blank, but in order to 

keep the file format valid, a space character [sp] must be entered, as in the 

[PASS] field of line 2 in the above example file.  

• If it is necessary to place the student in more than one class, the entire user line 

must be repeated as many times as necessary, each time with a different class 

code. (See line 5 in example above.)  

• When editing an existing Student, the "-" character directly in front of the class 

name will cause the system to remove the student from that class. If there is a 

space between the "-" character and the class name it will cause an error.  

 

The DELETE USERS SECTION  

Section Header  

[DELETE] 

Mandatory field. 

Must be placed between [square brackets] and followed by a carriage return. Spelling 

must be respected.  

 

Line format: 

 

Simple format:  

[DELETE]  

USERID [cr]  

 

Detailed format:  

[DELETE]  
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USERID [t] NAME [t]PASS [t] <+/-> ATT [t] INSTID [t] & [t] MENU [t] INACT [t] 

MAXTAB [t] BACKGROUND-NUM [t] LANG < [t] CLASS> [cr]  

 

Field format  

1. USERID: 

Mandatory field. 

Valid user ID you wish to delete. It can be a student ID or an instructor ID. Each 

user ID is followed by a carriage return.  

2. User Registration Line: 

Optional. 

 

It is sometimes convenient to simply take a copy the file that was used to import 

the users, change the header from [STUDENTS] to [DELETE] and keep the user 

registration line as they were without having to remove the other fields. This will 

result in the same than using the short format above.  

 

SAMPLE DELETE USER SECTION 

 

[DELETE]  

JSMITH  

JDUPONT  

or 

[DELETE]  

JSMITH       Smith, 

John      PWORD      DEF      MGAGNON      &      STUD      30      2      0      en  

JDUPONT      Dupont, 

Jacques      PWORD      DE      &      INST      30      7      0      en      PT  

 

  NOTES 

• Use the [delete] header when you want to delete only some users from the system. 

(See the [refresh] section below for more deletion options)  

• When importing a registration file that includes the [DELETE] header, the system 

prompts for a password to be allowed to continue the deletion process. This 

password is REMOVE DATA NOW.  

• Only Instructors and students can be deleted using the [DELETE] headers.  

• If using copy/paste to create your import file, please note that the carriage returns 

are lost in the process. 

A carriage return must be manually added at the end of each line that has been 

pasted. 
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The DELETE CLASSES SECTION  
 

Section Header 

[DELETE-CLASSES] 

Mandatory field 

Must be placed between [square brackets] and followed by a carriage return. Spelling 

must be respected.  

 

Line format 

 

Simple format:  

[DELETE-CLASSES] 

CLASSCODE [cr]  

Detailed format  

CLASSCODE [t] CLASS NAME [t] INSTID [t] TERM [t] ATT ADD [t] ATT 

REMOVE [cr]  

 

Field format:  

 

1. CLASSCODE: 

Mandatory field.  

Existing class you wish to delete. Each class code is followed by a carriage return.  

2. Class registration line 

optional. 

It is sometimes convenient to simply take a copy of the file that was used to 

import the classes, change the header to from [CLASSES] to [DELETE-

CLASSES] and keep the class registration lines as they were. This will result in 

the same than using the simple format above. If you do not have an existing 

[CLASSES] import file, use the simple format to delete your classes.  

 

SAMPLE DELETE CLASSES SECTION 

 

[DELETE-CLASSES] [cr]  

ESL01 [cr]  

FR02 [cr]  

or  

 

[DELETE-CLASSES] [cr]  

ESL01      English, level 1       JSMITH       fall       E1     F2 [cr] 

FRE02      French, level 2       MDUPONT            F2     E1 [cr]  
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NOTES 

• Use the [delete-classes] header when you only want to delete specific classes from 

the system. (See the [refresh] section below for more class deletion options)  

• When importing a registration file that includes the [DELETE] header, the system 

prompts for a password to be allowed to continue the deletion process. This 

password is REMOVE DATA NOW.  

• Instructors and students belonging to that class are NOT deleted.  

• If using copy/paste to create your import file, please note that the end carriage 

returns are lost in the process. A carriage return must be manually added at the 

end of each line that has been pasted. 

 

The REFRESH Section  
 

Section Header 
 
[REFRESH] 

Mandatory field.  

Must be placed between [square brackets] and followed by a carriage return. Spelling 

must be respected.  

 

Line format: 

 

REFRESH ALL [cr]        

or 

REFRESH STUDENTS [cr]  

or  

REFRESH CLASSES [cr]  
 

Field format:  

1. REFRESH ALL: 

Mandatory field 

Importing this file removes all registration information from the system including 

students and their recorded data, instructors, classes, and users activity records. 

Menu entries and lessons are not affected. They remain as they were prior to the 

import. The MASTER password is also reset to PWORD.  

2. REFRESH STUDENTS: 

Mandatory field 

Importing this file removes all student registration information from the system 

including their recorded data and their activity records. Menu entries, lessons, 
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instructors and classes are not affected. They remain as they were prior to the 

import.  

3. REFRESH CLASSES: 

Mandatory field 

This file removes all classes from the system. Students and their recorded data, 

instructors, menu entries and lessons are not affected. Students belonging to the 

classes deleted are not deleted from the system.  

Sample REFRESH FILE  

 

[REFRESH] 

REFRESH ALL  

 

[REFRESH] 

REFRESH STUDENTS  

 

[REFRESH] 

REFRESH CLASSES  

 

 

  NOTES 

• When importing a registration file that includes the [REFRESH] header, the 

system prompts for a password to be allowed to continue the deletion process. 

This password is  

REMOVE DATA NOW.  

• Whereas [DELETE] allows to delete some specific user IDs (including instructor 

IDs), [REFRESH] will delete all the registered users( depending on the refresh 

format chosen, either all users from the system including the instructors, or all 

students only from the system).  

• [REFRESH] never alters nor removes the menu layout. All lessons and menu 

links remain.  

• [REFRESH] followed by refresh all deletes classes as well.  

• Instructors cannot use any of the [delete] or [refresh] options.  

• If using copy/paste to create your import file, please note that the carriage returns 

are lost in the process. 

A carriage return must be manually added at the end of each line that has been 

pasted. 
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Import Procedure 

Once the file is created, save it as .txt in a path easily accessed.  

You can then proceed with the import:  

 

• Sign in with the system supervisor ID  

• In the CAN-8 supervisor menu, select System Administration then Import 

Registration Information.  

 

The first warning will appear; select YES to continue  

In the Import file window, locate the registration file previously created and select 

OPEN. 
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If the software detects the [REFRESH] or [DELETE] header in the file, the following 

warnings will be displayed:  

 

 

if the line was refresh all.  

or  

 

 

if the line specified refresh students. 

Select OK. 

The refresh password prompt appears. This added security prevents accidental system 

refresh.  

Type in REMOVE DATA NOW then select OK. This password cannot be changed. 
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The last warning window appears. Press OK if you wish to delete the users or CANCEL 

if you wish to stop the deletion process.  

 

  NOTES 

• If the registration file includes a [delete] or [refresh] section followed by either 

[inst], [students] or [classes], selecting Cancel in the Delete Confirmation 

window will only cancel the deletion, the users and classes registration will still 

proceed normally.  

• If the file does not include a deletion section, the import will start as soon as the 

import.txt file is selected. There is no password required for creating users or 

classes.  

• Depending on the number of records imported, this process can take a few 

minutes. 

  

Reading the Import log File 

Once the import is completed, the system will create a report file which logs all the 

processed records: successful registrations, warnings and errors.  

 

Whereas it is not necessary to read that log file if the Import Progress windows shows no 

error and no warnings, it will be necessary to verify it if some errors or warning are 

reported as illustrated below:  
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The registration process illustrated was completed, however several errors and warnings 

were reported.  

 

These are logged in a file created by the CAN-8 system. This file can be found in the 

same folder the registration file was saved in.  

This file is named import.rep. If the original import file was saved in the following 

location:  

C:\CAN8\import-march-2021.txt  

The system will create:  

C:\CAN8\import.rep  

 

This *.rep file can be opened with the text editor of your choice. The errors or warnings 

are listed per line.  

 

Some warnings are to be expected and are a normal matter in a registration import where 

students are edited instead of created, as shown in the illustration above. It is however 

important to verify the report file to analyze it and make sure the registration was 

successful.  

 

Both warnings and errors may result from formatting error, in which case the import  

In rare cases, errors can be reporting issues at the server level. If such is the case, basic 

troubleshooting of the server software and the server machine is necessary. Contact the 

IT department if you encounter such error.  

 

The table below lists the warnings and errors reported, their signification and what to fix:  
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Error/Warning Reported Error Type 

Import ABORTED at line xxx  

ALL RECORDS IN IMPORT FILE MAY NOT 

HAVE BEEN PROCESSED! 

Server error. 

The registration import was 

not successful 

Troubleshooting:  

Check network connection. Check CAN-8 server process. Contact IT  

line xxx: ***ERROR - Found unknown record tag:  Header Format error  

- The section was ignored. 

Troubleshooting:  

Check for spelling mistake or invalid header. Also check if the [ or ] (open and closed 

square brackets) characters are missing from the header or present in one of the fields 

on the line mentioned. These characters are reserved for headers. 

line xxx: *** ERROR - Minimum info ID, NAME, 

PASSWORD was invalid  

line xxx: Line ignored! 

Line Format error.  

The user was not created 

Troubleshooting:  

Check if line xxx was blank. If yes, you may ignore this error. Otherwise check on the 

line mentioned if the fields are all present and properly separated by tabs. Either a tab, 

a place holder or a mandatory field missing. 

line xxx: *** ERROR - Unknown refresh command in 

refresh section 

Field format error in refresh 

section  

The refresh section was 

ignored. 

Troubleshooting:  

Check for spelling mistake, or invalid command. The only 3 valid commands are 

refresh all, refresh classes and refresh students 

line xxx: *** ERROR - No username on line Delete line format error  

Line was ignored 

Troubleshooting:  

Check for empty (blank) line. Also check that the line format is respected if the line is 

of the full format (check tabs and fields). 

line xxx: --- Line found - no tag: % Missing header.  

Section ignored.  

Troubleshooting:  

The system did not find any section header before the line specified. Add the headers. 

line xxx: *** ERROR - Strange characters in record: 

%s 

Field format error.  

The line was ignored.  

Troubleshooting:  

Check fields on line specified for characters that are not accepted in these fields. Also 

check for missing field. This would cause the next fields' inputs to move one place to 

the left thus causing this error. This line was ignored, the import continued 

line xxx: *** ERROR - Class xxx already exist Class creation failure 

Troubleshooting:  

The class already exists and cannot be created twice. You may ignore this error. 

line xxx: *** ERROR - write error creating class %s  System error  

Class was not created 
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Troubleshooting:  

The system was unable to create the class on the server. The server file may have been 

locked or the server inaccessible. Contact IT 

line xxx: *** ERROR - class code is invalid %s Field Format error. 

Class was not created 

Troubleshooting:  

Check if the name either includes too many characters or characters not allowed 

line xxx: *** ERROR - server would not create class Server error.  

Class not created.  

Troubleshooting:  

The maximum number of classes allowed might have been reached, the server's disk 

might be full, server files are flagged Read Only. Try to create a class manually. If the 

same error appears, try to delete a class then recreate a new one. If no error appears, 

then the maximum classes allowed has been reached. Delete the classes no longer in 

use. Otherwise contact IT.  

--- Instructor: xxx not found, student will belong to 

MASTER 

Warning  

The student has been 

registered. 

Troubleshooting:  

Information error in [students] section. The instructor ID entered does not exist. This 

student, although successfully created, does not belong to any instructor. If it is 

important that the student be registered under the instructor's name, correct the INSTID 

field and run this line again or the instructor can delete then recreate the student 

manually. 

line xxx: *** ERROR User xxx has invalid 

icon/normal setting. Must be I, N, L, M, O, or B 

line xxx: *** ERROR User xxx has invalid 

windows/traditional style setting 

Legacy format error.  

The user was not created 

Troubleshooting:  

Only shows for version pre-dating 2010. Check the mentioned fields and correct them. 

You may be missing one of these fields, a tab, or have used characters not allowed. 

line xxx: *** ERROR User xxx has invalid language 

specified -  

Field Format error User was 

not created 

Troubleshooting:  

Check for error in the language field or tabs missing in the line after the language field. 

line xxx: *** ERROR User xxx already exists but is 

not being added to another class 

Line format error.  

Line ignored 

Troubleshooting:  

This usually shows when re-importing a file after fixing some of the errors. If it is a 

first import, this line may be repeated. Since the user was previously registered, and 

this line does not bring any changes to the existing profile, it is ignored. Remove the 

line to avoid the error in the log file.  

line xxx: --- User xxx already exists, adding to class 

xxx if possible 

Warning.  

User is added to the class. 

Troubleshooting:  

This warning is for information purpose during user edition. The system recognizes 
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that the user ID already exists and is processing the changes to the profile. In this case, 

the user is being placed in another class 

line xxx: --- Student xxx already in class xxx  Warning.  

No changes done to the user 

Troubleshooting:  

Information purpose only. The system recognizes that the user ID already exists, and 

that this line is identical to the student settings. Either that line is doubled or the user 

was previously created. Delete the double entry to avoid warning in the log file. 

line xxx: *** ERROR user xx was not created by the 

server . 

Server error. 

Student NOT created 

Troubleshooting:  

The server's disk might be full or the files locked. Check if the user can be created 

manually. Contact IT. 

line xxx: *** ERROR Student xxx just created could 

not return number!  

Server error.  

Student NOT created 

Troubleshooting:  

Disk error. Contact IT. Check if the disk is full or damaged.  

line xxx: --- class xx not found. Unable to add student 

to class  

Warning.  

Student created 

Troubleshooting:  

The class code does not exist. The student has been created but has not been added to 

that class.  

• Check for spelling mistake in the class field, check for missing tabs in the line  

• Make sure the [classes] section is placed before (above) the [students] section 

in the import file so that the classes are created first, then the students added.  

• If the class does not exist in the system, add a [classes] section and add a line to 

create the class then re-run your import file or add the students manually  

line xxx: *** ERROR Student xxx is already in 16 

other classes 

Maximum reached. Student 

not added to class 

Troubleshooting:  

This error shows when a student profile is being edited. This student already belongs to 

the maximum class allowed (16) and cannot be added to another one. Remove the 

student from some of the other classes using the class function menu or using the - 

character in the import file to remove some classes before importing again.  

line xxx: *** ERROR Write error when adding student 

to class  

Server error. 

Troubleshooting:  

Disk error. Contact IT Check if the disk is full or the server files locked 

line xxx: *** ERROR User: xxx not found, not deleted  Delete format error  

Student not deleted 

Troubleshooting:  

Under the [delete] section, the student at the line mentioned does not exist and cannot 

be deleted. Check for spelling mistake in the USERID field  
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line xxx: *** ERROR student xxx was not deleted by 

the server.  

Server error  

Student not deleted 

Troubleshooting:  

Contact IT. Check id disk full or server files locked  

NOTE: 

• When re-importing a file, lines that did not cause an error or a warning the first 

time will cause a warning the second time: user/class/instructor already exist.  

• Review the errors and re-import your file until you do not see any errors.  

 

 

 

 

 

 

 

 

This concludes the System Administration chapter of this reference 

manual. Other chapters are available as follow: 

• player.pdf gives general information about CAN-8 and describes the 

layout of the student program. 

• For information on creating teaching materials, see planner.pdf 

• For student monitoring and evaluations see tracker.pdf 

• babilon.pdf details the group conversation function.  

For technical or software support, renewal of your maintenance agreement or 

information about its status: 

416 968 7155 ext. 502 Toll Free in North America: 

 1 855 305 9937 ext. 502 support@can8.com 


